OVERWHELMED
Sometimes youth on the
Autism Spectrum become
so over-whelmed they are
unable to function. Most
situations can be avoided
by asking the youth to
gauge their own comfort
level.
Because the body
language of Autism
Spectrum people is
DIFFERENT from others,
you may not be able to tell
when a youth is becoming
overwhelmed or agitated.

1. Shutdown – Under
severe stress, they may
refuse to engage or
participate
2. Meltdown – Under
severe sensory distress,
they may cry or yell
3. Safe Place - The best
way to deal with
impending shutdown or
meltdown is the use of
“safe place” or allowing
some time away from
the group.
If, despite all strategies,
a youth becomes
overwhelmed and
begins to meltdown the
best strategy is QUIET
AND CALM. Loud voices
or even attempts at
reasoned discussion
may only exacerbate.

Tips for
Youth Group Leaders
Common
characteristics of
youth on the Autism
Spectrum
The Rev. Rebecca Black

DIFFERENCES IN LANGUAGE
AND VERBAL PROCESSING
1. Literal – Youth on the Autism
Spectrum tend to take things
literally. Although many can
understand sarcasm or
metaphor, be sure to explain
EXACTLY what you mean. And
don’t make a fuss if they get it
wrong – they’re not trying to be
funny or challenging.
2. Body Language - Youth on the
Autism Spectrum may not
understand body language. They
may avoid eye contact, and most
likely will not appreciate any
form of physical contact. Arrange
seating so youth can have
“privacy” for/from facial
expressions. Don’t think they’re
not engaged or not listening!
Don’t try to force eye contact—
this causes distress.
3. Hesitation in Speaking - Youth
on the Autism Spectrum
sometimes repeat words or
hesitate between words – this is
usually because they think most
readily in pictures and are having

trouble choosing which words to
use. Be patient and don’t finish
sentences – AS youth often have
amazing insights and it is worth
waiting for them to verbalize.
4. VISUALPROCESSING Acuity Youth on the Autism Spectrum
prefer written instruction to
verbal, and picture illustrations
to verbal ones. Speaking urgently
or loudly will cause them
distress, and too much audio
input will cause them to “shut
down.” Always have a quiet area
available for decompression
from too much input.
5. Monologuing or
Perseveration - Youth on the
Autism Spectrum are often
“deep” learners – studying a
narrow topic field exhaustively.
They tend to “monologue” or
“perseverate” on these
preferred topics and be unaware
of social cues that they have
gone on too long. Help them by
intervention and redirection.
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SENSORY

TRANSITIONS

Many youth on the Autism
Spectrum are hypersensitive to
their sensory environment.
Helping them be comfortable
will assist in their engagement
with the group.

Many youth on the Autism
Spectrum have difficulty shifting
direction or attention from one
topic or task to another

1. Light – flickering or buzzing
lights can be painful. Replace
bulbs or fixtures if necessary.
Many AS youth find darkness or
sudden changes in light
uncomfortable. Try not to use
darkness or changes such as
flicking lights on and off as a
signal.
2. Noise – Youth on the Autism
Spectrum are extraordinarily
sensitive to sound, and are easily
overwhelmed in crowds, or
when several people are talking
at once. Try to assist the group in
taking turns in conversation.
Allowing the youth to wear ear
plugs or headphones will also
help.
3. Personal Space – Youth on the
Autism Spectrum are often
completely oblivious to personal
space and may unintentionally
offend others. It’s OK to gently
remind them to “step back.”
4. “SAFE” Space – providing an
agreed-upon “safe space” where
youth can retreat when
overwhelmed will help them stay
engaged with the group. This
space should be within eye and
earshot of the group, but allow
the youth to turn away.
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1. A VISUAL cue is preferable to
verbal
2. Staged “warnings” of
transitions will help – “In ten
minutes, we will…” “5 more
minutes..” etc.

EMOTIONAL MATURITY and
“NO FILTER”
An Autism Spectrum diagnosis is
based on developmental delays.
This means that AS youth can lag
behind their peers in several
ways—especially emotional
maturity and social skills.
1. Put expectations in writing

3. Clarity – Mean what you say
and say what you mean. Use a
timer, set limits and stick to
them. Youth on the Autism
Spectrum are very literal and
rigid—if you say “I’ll be back in
10 minutes” then please do your
best to stick to that. Being loose
about terminology or times will
cause distress.

2. Don’t assume youth know
“correct” or “age-appropriate”
ways to act
3. Understand that social skills
and negotiating social situations
are the equivalent of an
unknown language to Autism
Spectrum Youth. Other youth
will probably also benefit from
frank discussions about the
“whys” of social behavior.
4. Many Autism Spectrum youth
do not understand “social talk” –
they are extremely honest and
do not understand why what
they say might be offensive to
others.

CHANGE
One of the hallmarks of people on the Autism Spectrum is a resistance to
change. Autism Spectrum Youth almost universally prefer all things in an
unvarying order, and will not assume that general rules and expectations
apply in new situations.
1. Preparing these youths for any changes in routine, in agenda or in
expectation should be done as much in advance as possible.
2. Even minor changes can be stressful – Autism Spectrum youth do not
“generalize” from one situation to another. Just because a rule applies in
one space doesn’t mean to them that it applies in others.
3. Explicit “rules” about expectations in each and every space the group
uses will reduce anxiety
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expectations in each and every
space the group uses will reduce
anxiety.
the columns you want to balance. On
the Insert menu, click Break. Click
Continuous. Word inserts a continuous
section break, which balances the text
equally among the columns.
If you want to force a new page to start
after the balanced columns, click after
the continuous section break and then
insert a manual page break.
Removing Columns

If your document is divided into
sections, click in the section or select
multiple sections you want to change.
Continued from Page 1

Continuing Articles
across Pages

Choose Columns from the Format
menu, and then click One.

Formatting Text
Boxes
Type your sub-heading here
Your By-line
You can change the look of a linked text
box by applying color, shading, borders,
and other formatting. If you want to
format all the text boxes in an article,
you must format them individually.
Select the text box and double click its
border. If you want to change the color
or borders on a text box, choose the
Colors and Lines tab. To change the
size, scale, or rotation, click the Size
tab. To change the position of the text
box on the page, click the Position Tab.
If you have other text surrounding the
text box, and want to change the way
the text wraps around it, click the
Wrapping tab.

Your By-line
Some of the articles in this newsletter
were created using linked text boxes,
which allow articles to flow
continuously across pages. When you
add lines of words to a text box, the
words in the following text box flow
forward. When you delete words from a
text box, the words in the next text box
move back. You can link several text
boxes in an article and you can have
multiple articles in a document. The
links do not have to occur in a forward
direction.
To insert linked text boxes in a
document, click Text Box on the Insert
menu. Click and drag in your document
where you want to insert the first text
box. Insert additional text boxes where
you want the text to flow.
To select the first text box, move the
pointer over the border of the text box
until the pointer becomes a four-headed
arrow and then click the border. Click
the right mouse button, click Create
Text Box Link, and then click in the
text box where you want the text to

The rest of this is placeholder text. As
with the rest of the newsletter, just
select it and overwrite it with your own
content. This is placeholder text. This is
placeholder text. This is placeholder
text.
This is placeholder text. This is
placeholder text. This is placeholder
text. This is placeholder text. This is
placeholder text. This is placeholder
text. This is placeholder text This is
placeholder text.
This is placeholder text. This is
placeholder text. This is placeholder
text. This is placeholder text. This is
placeholder text. This is placeholder
text. This is placeholder text. This is
placeholder text. This is placeholder
text. This is placeholder text. This is
placeholder text. This is placeholder
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This Month’s
Events
Date
Time, Location
Event name
Type a description of your event
here. For more information call
000-0000.
Date
Time, Location
Event name
Type a description of your event
here. For more information call
000-0000.
Date
Time, Location
Event name
Type a description of your event
here. For more information call
000-0000.
Date
Time, Location
Event name
Type a description of your event
here. For more information call
000-0000.
Date
Time, Location
Event name
Type a description of your event
here. For more information call
000-0000.
Date
Time, Location
Event name
Type a description of your event
here. For more information call
000-0000.
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Continued on Page 4
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Continued from Page 3
Date, Time
Location
Event name
Type a description of your event
here. For more information call
000-0000.
Date, Time
Location
Event name
Type a description of your event
here. For more information call
000-0000.
Date
Time, Location
Event name

text. This is placeholder text. This is
placeholder text. This is placeholder
text. This is placeholder text. This is
placeholder text. This is placeholder
text. This is placeholder text.

To edit a picture, click on it to activate
the Picture toolbar. You can use this
toolbar to adjust brightness and contrast,
change line properties and crop the
image.

This is placeholder text. This is
placeholder text. This is placeholder
text. This is placeholder text. This is
placeholder text. This is placeholder
text. This is placeholder text. This is
placeholder text.

You can also use the Format Picture
dialog box to edit a picture. To open it,
select the picture, click the right mouse
button, and click Format Picture. You
can change the size and position of the
picture, crop it, adjust the brightness
and contrast, and change the text
wrapping. The pictures in this template
use the tight wrapping style.

Inserting and Editing
Pictures
Your By-line

Type a description of your event
here. For more information call
000-0000.

You can replace the pictures in this
template with your company's art.
Select the picture you want to replace,
point to Picture in the Insert menu, and
click From File. Choose a new picture
and then click Insert. Select the Link to
File box if you don’t want to embed the

For more detailed editing, double-click
on the graphic to activate the drawing
layer, where you can group or ungroup
picture objects, re-color, or delete
objects.
This is placeholder text. This is
placeholder text. This is placeholder
text. This is placeholder text. This is
placeholder text. This is placeholder
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text. This is placeholder text. This is
placeholder text.
This is placeholder text. This is
placeholder text. This is placeholder
text. This is placeholder text.
This is placeholder text. This is
placeholder text. This is placeholder

Questions and Answers
Q: I would like to change some of
the text box shading to improve the
print quality. Can that be done?
A: Yes. To change the shading or
color of a text box, select it and
double click its borders to open the
Format Text Box dialog box. Click the
Colors and Lines tab and then
choose the new color from the Color
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drop-down list in the Fill section.

text. This is placeholder text. This is
placeholder text. This is placeholder
text. This is placeholder text. This is
placeholder text. This is placeholder
text. This is placeholder text. This is
placeholder text.

you’re mailing without an envelope,

change the text in the footer, select it

seal with a label.

and type your new text. To change

Q: I would like to use my own clip
art. How do I change the art without
changing the design?
A: To change a picture, click on the
picture, then point to Picture on the

the border, click Borders and Shading
on the Format menu.
Q: Can I save a customized
newsletter as a template for future
editions?

Insert menu and click From File.

A: Yes. Type your own information

Choose a new picture, and click

over the sample text and then click

Insert.

Save As on the File menu. Choose

Q: How do I change the text and

Document Template from the Save

. . . . . . borders
. . that. appear
. .at the. bottom
. .of . . as.type.drop. down
. list. (the. extension
. .

Q: What’s the best way to print this
newsletter?

art in the newsletter. This is a good idea
if you need to minimize your file size.
Embedding a picture adds significantly
to the size of the file. You might want to
consider embedding a picture if file size
is not an issue and you use a picture in
every edition of your newsletter.

every page?
A: Click Headers and Footers on the

should change from .doc to .dot).

Save the file under a new name. Next
time you want to create a newsletter,
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